
Arduino und Amateurfunk (Fortsetzung)

Workshop USKA-Sektion Solothurn am 2.Sept 2023 .

HB9BFD Roland

Thema: Mit ESP32 
oder ESP8266 und 

MQTT Daten 
übertragen
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§ Unterrichtsziele:
« …. nötige Kompetenz für die Programmierung von ESP’s
erwerben. Programme vom Internet anpassen und 
verwenden können.»

« ….ESP8266 und/oder ESP32 programmieren können.»

Einleitung



5

© USKA Sektion Solothurn 2023

Wieso ESPs von der Firma Expressif?

• Günstig (China –Clone für Fr. 2.- erhältlich)

• Grosse Community im Internet

• Viele Programme und Libraries (Bibliotheken)

• Grosse Anzahl von Sensoren und Shields

• Schnelle Realisierung von Ideen

• Leicht erlernbare Programmiersprache C++

• Viele Projekte bereit zum Anpassen auf meine 
Bedürfnisse
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§ Arduino Grundlagen
4 Unterschiede SPS – MikroController
4 Funktion, Hardware
4 Software
4 Grundlagen der Programmierung
4 Übungsbeispiel Blinklampe (bis hierher im 1.Kurs 2021!)

§ Bussysteme mit Arduino
4 Verwendung von Bibliotheken
4 «Bus Systeme» mit Arduino: Seriell, USB, I2C, 1-Wire
4 Übungsbeispiel LCD Anzeige mit Arduino

Inhalt der Präsentation
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§ Sensorik
4 Sensorik mit Arduino
4 Temperaturmessung 
4 Übungsbeispiel Dallas Chip

§ ESP32 oder ESP8266
4 Vorbereitungen in IDE, Unterschiede, 

§ Kommunikation
4 Kommunikation mit MQTT Broker
4 Übermitteln von Messwerten an MQTT Broker

§ Anwendungs-Beispiele im Amateurfunk

Inhalt der Präsentation



8

© USKA Sektion Solothurn 2023

Arduino Grundlagen
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§ Inhalt:
4 Unterschiede SPS – MikroController (Arduino HW)
4 Funktion, Hardware
4 Software
4 Grundlagen der Programmierung
4 Übungsbeispiel Blinklampe

Arduino Grundlagen
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§ Lernziel:
4 Du bist in der Lage zu entscheiden, welche Lösung für dein 

Problem am meisten Sinn macht (Kosten, Performance, 
Sicherheit, Ersatzteile, Dokumentierbarkeit, Lifetime, ….)

4 Umgang mit den Arduino Beispielen vom Internet und der 
Hardware (Aliexpress, Bangood, DealExtreme,…..).

4 Blinklampe programmiert mit dem ESP MCU-Board
4 Daten an MQTT-Broker senden

Arduino Grundlagen
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§ Open-Source Soft- und Hardware

§ Einfaches E/A Board meist basierend auf Atmel-AVR 
oder ESPs von der Firma Espressif

§ Spannungsversorgung meist via USB

§ Intern entweder 5VDC oder 3.3VDC 
Vorsicht ESP’s vertragen keine 5V an den Eingängen!!

§ Programmierung über USB (nackte Chips/Boards via 
RS232 und/oder USB-Wandler )

§ Shields sind sogenannte Erweiterungen, die direkt 
aufgesteckt werden.

Funktion, Hardware (Arduinos)



23

© USKA Sektion Solothurn 2023

§ Integrierter Bootloader: Programmierung direkt über 
serielle Schnittstelle, respektive USB möglich

§ Integrierte Entwicklungsumgebung (IDE), kostenlos

§ Läuft auf Windows, Linux und macOS (bei mir leider 
nicht!)

§ Arduino-IDE hat Code Editor und Compiler eingebunden

§ Zusätzliche Bibliotheken vereinfachen die 
Programmierung in C und C++ stark

Software Arduino IDE

Der Bootloader ist ein kleines Programm, welches dem Atmel ATMega328P-pu 
sagt, dass er ein Arduino (genauer gesagt ein Arduino-Uno) werden soll. ... 
Der Bootloader sorgt auch dafür, dass der Atmel ATMega328P-pu nach dem 
Einschalten prüft ob ein Programm auf ihm gespeichert ist.
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§ Die IDE  (Integrated Development Environment) habt ihr 
bereits zuhause auf eurem PC installiert! (?)

§ Sonst kann sie von: www.arduino.cc geladen werden. 
Ich verwende die englische Version (1.8.57.0), was 
immer das bedeutet....Ihr könnt problemlos auch die 
deutsche Version nutzen oder die Version 2.2.

§ Bei mir hat die IDE Probleme gemacht, wenn ich die 
Programme (=Sketches) auf dem Netzwerk speichern 
wollte, also verwende ich den C:-Drive.

Software Arduino IDE: Programmiersoftware
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§ Arduino IDE, File> Preferences

Software Arduino: ESP32/ESP8266 Add-on

§ Für ESP32 und/oder ESP8266 diese Zeile einfügen: 
§ http://arduino.esp8266.com/stable/package_esp8266com_index.json, 

https://dl.espressif.com/dl/package_esp32_index.json
§ Damit sollten unter >>Tools>>BoardsManager neue Einträge für ESP-Boards erscheinen

Sieht in Version 2 
etwas anders aus!
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§ Für Espressif-Chips unbedingt in Preferences
zusätzliche URLs einfügen…. Bedeutet online sein !!

Software Arduino IDE: Präferenzen einstellen
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§ Hier hatte ich am meisten Mühe, das richtige Board zu 
finden, denn ich kaufte Chinaschrott, meist ohne weitere 
Bezeichnungen der Boards.

§ Wir verwenden ESP8266-12E NodeMCU V1.0

Software Arduino IDE : Board auswählen
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Software Arduino IDE : Board auswählen

Mit externer Antennenbuchse

Mit OLED Display

Praktisch 
nackter Chip
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§

ESPs

Welchen Typ ESP soll ich verwenden?
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§ Oftmals fehlt der entsprechende Treiber für die USB-
Schnittstelle, sodass die Software keinen seriellen 
(COM) Port sieht.

§ CH3406, 341 oder FTDI 210x oder….googeln und 
hoffentlich ohne einen Virus zu laden

§ Wichtig: Es gibt USB-Kabel, die nur zum Laden 
geeignet sind, aber nicht zum Daten übertragen. Falls 
ihr so ein Kabel erwischt, so habt ihr Pech und es wird 
in der IDE Software eventuell kein Port angezeigt.

Software Arduino IDE: Treiber für USB/Seriell-Chip
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Software Arduino IDE: Programmier-Ports

Port einstellen!
Falls es nicht Ping macht beim Anschliessen des Arduinos, dann fehlt vielleicht der 
Treiber für den USB Chip auf dem Board und die Schnittstelle wird nicht als USB/Com
erkannt. Abhilfeà richtigen Treiber im Internet dazu suchen und installieren.
CH340 Treiber für Windows: https://download.bastelgarage.ch/Produkte/CH341SER.ZIP

https://download.bastelgarage.ch/Produkte/CH341SER.ZIP
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§ Wenn man Arduino IDE aufruft, dann kriegt man zuerst 
ein Grundgerüst für die Programmierung (oder das 
zuletzt bearbeitete Programm erscheint).

Software Arduino DIE. Grundgerüst für Programm

Wichtig: Unsere Befehle werden 

innerhalb der Klammern {} geschrieben!

Zusätzlich werden Befehlszeilen jeweils mit «;» beendet (siehe folgendes Beispiel)! Vergiss 
ich selbst immer wieder!
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§ Für die Programmierung kennt man grundsätzlich zwei 
Strukturfunktionen:
4 setup()      wird beim Start des Programmes einmalig 

aufgerufen
4 loop() wird kontinuierlich durchlaufen, ähnlich wie bei 

einer SPS (bei Siemens typischerweise OB1).
4 Zusätzlich definiert man am Anfang des Programmes die 

Ein-Ausgänge, Konstante Werte, Instruktionen für den 
Compiler etc und ruft hier Bibliotheken auf.

Software Arduino IDE
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§ ; damit werden einzelne Instruktionen getrennt

§ {} unterscheiden der Programmabschnitte

§ // für einzeiligen Kommentar

§ /*……*/ für mehrzeiligen Kommentar

§ () übergeben von Parametern bei Funktionen

§ #define zum Definieren von Anfangswerten 

§ #include zum Einbinden von Bibliotheken 

Software Arduino IDE: Syntax
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§ Digital I/O
4 digitalRead() 

digitalWrite() 
pinMode() 

§ Analog I/O
4 analogRead() 

analogReference() 
analogWrite() 

§ Zero, Due & MKR Family
4 analogReadResolution() 

analogWriteResolution() 

Grundbefehle der Programmierung (Functions)
§ Time

4 delay() 
delayMicroseconds() 
micros() 
millis() 

§ ….

§ …..  see Internet

§ Communication
4 Serial 

Stream 
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§ Arduino Datentypen und Konstanten

Grundlagen der Programmierung
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§ Variablen
4 Eine Variable ist ein kleiner Speicher, in den eine 

Information einer bestimmten Form passt. Die Form wird 
durch den sogenannten Variablentyp bestimmt.

Grundlagen der Programmierung

Variablentyp Bedeutung Beschreibung

int ganze Zahlen -32'768 bis 32'767

long ganze Zahlen -2'147'483'648 bis 
2'147'483'647

float Fließkommazahl gebrochene Zahlen

char Character
Alphanumerische 
Zeichen (Buchstaben, 
Zahlen, Sonderzeichen)
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ESP Platine (ESP32 oder ESP8266)
Betriebsspannung : 5 V via Mikro-USB, intern wird daraus 3.3V gemacht, 
Vorsicht: die Eingänge vertragen nur 3.3V
USB-Programmier-Kabel zum PC, Software IDE auf PC

Übung: Blinkende LED Was braucht ihr dazu?

Auf dem PC ist IDE geladen
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Übung: Blinkende LED 

Dieses Board hat, wie die meisten Boards eine 
eingebaute LED. Diese wird mit LED_BUILTIN 
angesprochen
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§

Übung: Blinkende LED

Mit diesem Beispiel-Programm wird die interne LED zum Ausgang 
deklariert und nachher jeweils mit HIGH und LOW beschaltet!

Grundsätzlich kann jeder Digital-Pin als Ein- oder Ausgang 
verwendet werden. Ein paar Pins sind jedoch reserviert für die 
Programmierung (RX/TX ….etc).

LED_BUILTIN = GPIO2 = D4
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Übung: Blinkende LED: Wie heissen die Pins?

Antenne

Da ist auch LED_BUILTIN 
angeschlossen

Programmiert werden die Pins über die GPIO-Nummer und nicht via Bezeichnung 
auf der Platine, denkt daran! Kann je nach Programmumgebung jedoch anders sein.
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IDE Programmiersoftware

Nicht vergessen, das Programm unter einem Namen 
zu speichern mit "save as". Nachher genügt "save".
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§ Da ich den Ausgang 13 (D7) als LED benutzen möchte, 
kann ich ihn auch als Variable ersetzen:
4 int ledPin=13;

§ Nun kann ich im Programm "ledPin" verwenden.

§ Die Variablenzuweisung erfolgt vor "void setup" und ist 
nachher überall gültig.

§ Muss nun natürlich eine externe LED mit Vorwiderstand 
470 OHM gegen Masse an D7 anschliessen.

Übung: Blinkende LED

Arduino, erstes Programm
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Übung: Blinkende LED

Arduino, erstes Programm

§ LED_BUILTIN ersetzen durch Pin 13 
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Übung: Blinkende LED

§ Programm eintippen, abspeichern (ev. anschliessend 
Arduino IDE schliessen und Programm "Blinken" wieder 
laden.

§ Du kannst mit Copy/Paste arbeiten um Programme zu 
editieren!  à einfach probieren!
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Übung: Blinkende LED (weitere Versuche)

Wenn man "Upload" anklickt, so wird das 
Programm übersetzt (compiliert) und wenn alles 
gut ist, auf den Chip geladen….man sieht dies an 
den flakernden LED's.
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§ Bitte die Ein-/Ausschaltzeiten ändern und Programm 
wieder übersetzen und auf Arduino laden. 

Übung: Blinkende LED (weitere Versuche)
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ESP8266 oder ESP32 

ESP8266
§ 1 Kern

§ 80 Mhz

§ 160 KB

§ 17 GPIOs

§ 2 SPI/1 I2C

§ 1 ADC

§ 10 Bit

§ 80...170 mA (im 
Deep Sleep nur 
0.5uA)

ESP32
§ 2 Kerne

§ 160 Mhz

§ 520 KB

§ 36 GPIOs

§ 4 SPI / 2 I2C

§ 16 ADC

§ 12 Bit

§ 260 mA (WLAN) ! Ein Stromfresser also!

§ BlueTooth, ESP32-ESP32

Wichtig: 3.3V Ein-/Ausgänge, WLAN integriert,
kann mit OTA (=Over The Air) programmiert werden!!! 
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ESP32 Board
Antenne

μUSB Flash Reset
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ESP8266 Board
Antenne

μUSB Flash Reset
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ESP Boards
§ Wozu sind die Buttons RST und Flash?

§ Zum Laden von Programmen steckst du den NodeMCU
an den PC an. Anschliessend musst du beide Taster auf 
dem Board drücken (RST und FLASH). Dann zuerst 
RST loslassen und anschliessend erst FLASH. Nun 
solltest du in der Arduino IDE das COM Port anwählen 
können und das Programm auf den Controller kopieren 
können.

§ Muss nicht sein, je nach Modell werden die Buttons 
durch die IDE-Software automatisch richtig gesteuert !!
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§ Arduino hat nur einen Standardsatz von Bibliotheken, 
fehlende können mit «Manage Library» oder direkt vom 
Internet als ZIP-Datei runtergeladen werden.

§ Dazu wird Sketch -> Include Library-> Add .ZIP Library 
aufgerufen. Die ZIP Datei wird dann automatisch sauber 
ins Verzeichnis eingebunden und steht nun zur 
Verfügung.

Fehlende Bibliotheken in Arduino
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§MQTT 
Kommunikation via Mosquitto Broker
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§ Wir können dazu HIVEMQ (= Cloud Server) verwenden!

Kommunikation via HIVEMQ Free Cloud Broker
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Kommunikation via Mosquitto Broker
§ Lernziel:

4 Du erkennst die Möglichkeiten von IoT (Internet of Things).
4 Kannst eigene Daten auf dein Handy übertragen.
4 Bibliotheken runterladen und einbinden
4 WLAN konfigurieren
4 Analogeingang verwenden
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Kommunikation via Mosquitto Broker
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MQTT (kopiert aus Wikipedia)
Message Queuing Telemetry Transport (MQTT) ist ein offenes 
Nachrichtenprotokoll für Machine-to-Machine-Kommunikation 
(M2M), das die Übertragung von Telemetriedaten in Form von 
Nachrichten zwischen Geräten ermöglicht, trotz hoher 
Verzögerungen oder beschränkter Netzwerke.

Entsprechende Geräte reichen von Sensoren und Aktoren, 
Mobiltelefonen, Eingebetteten Systemen in Fahrzeugen oder 
Laptops bis zu voll entwickelten Rechnern. 

Das MQTT-Protokoll ist auch unter älteren Namen wie 
„WebSphere MQTT“ (WMQTT), „SCADA-Protokoll“ oder „MQ 
Integrator SCADA Device Protocol“ (MQIsdp) bekannt.

Die Internet Assigned Numbers Authority (IANA) reserviert für 
MQTT die Ports 1883 und 8883. MQTT-Nachrichten können 
mit dem TLS-Protokoll verschlüsselt werden. 

Arduino, Mosquitto
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MQTT  (kopiert aus Wikipedia)
Interessant ist, dass ein MQTT-Server („Broker“) die gesamte 
Datenlage seiner Kommunikationspartner hält, und so als 
Zustands-Datenbank benutzt werden kann. 
So ist es möglich, kleine unperformante MQTT-Geräte mit einem 
MQTT-Broker zu verbinden, wobei die Geräte Daten einsammeln 
und/oder Befehle entgegennehmen, während ein komplexes 
Lagebild nur auf dem MQTT-Broker entsteht und hier oder durch 
einen leistungsfähigen Kommunikationspartner ausgewertet werden 
kann. 
Stelleingriffe können so von einer oder mehreren leistungsfähigen 
Instanzen an den MQTT-Broker übermittelt und auf die einzelnen 
Geräte verbreitet werden. 
Dadurch eignet sich MQTT sehr gut für Automatisierungslösungen 
und findet im Bereich IoT durch die einfache Verwendung große 
Verbreitung. 

Arduino, Mosquitto
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MQTT Mosquitto Broker Funktion

Arduino, Mosquitto

s2.eu.hivemq.cloud

HB9BFD

“HB9BFD/Poti“ 
=“10“

“HB9BFD/Poti“ 

=“10“

“HB9BFD/Poti“ =“10“

“HB9BFD/Poti“ “HB9BFD/Poti“

Poti anstelle eine 
Temperaturfühlers
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MQTT Beispiel Programm

Arduino, Mosquitto

s2.eu.hivemq.cloud

Arduino Configuration

•Download and install CH340G USB driver

•Install ESP8266 module

•Install PubSubClient library (by Nick O’Leary)

•Sketch -> Include Library -> Manage Libraries… -
> Type PubSub in Search field -> Install

https://kig.re/downloads/CH34x_Install.zip
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MQTT Beispiel Programm für Poti Pos senden
#include <ESP8266WiFi.h>
#include <PubSubClient.h>
const int analogInPin = A0; // ESP8266 Analog Pin ADC0 = A0

#define wifi_ssid " HB9BA "
#define wifi_password "xxxxx"

#define mqtt_server "b48168793db644848e07472b4fb7ea01.s2.eu.hivemq.cloud"

// MQTT Cloud address
#define Topic "HB9BFD/Poti"

WiFiClient espClient;
PubSubClient client(espClient);

void setup() {
Serial.begin(115200);
setup_wifi();
client.setServer(mqtt_server, 1883);
}

void setup_wifi() {
delay(10);
WiFi.begin(wifi_ssid, wifi_password);
while (WiFi.status() != WL_CONNECTED) {
delay(500);
Serial.print(".");
}
}

void reconnect() {
// Loop until we're reconnected
while (!client.connected()) {
Serial.print("Attempting MQTT connection...");
if (client.connect("nodeMcuHB9BFD")) {
Serial.println("connected");
} else {
Serial.print("failed, rc=");
Serial.print(client.state());
Serial.println(" try again in 5 seconds");
delay(5000);
}
}
}

bool checkBound(float newValue, float prevValue, float maxDiff) {
return newValue < prevValue - maxDiff || newValue > prevValue + maxDiff;
}

long lastMsg = 0;
float potiPos = 0.0; // value read from the poti 
float diff = 10.0;

void loop() {
if (!client.connected()) {
reconnect();
}
client.loop();

long now = millis();
if (now - lastMsg > 30000) {
// Wait a few seconds between measurements
lastMsg = now;
potiPos = analogRead(analogInPin);

if (checkBound(potiPos, prevPos, diff)) {
prevPos = potiPos;
Serial.print("Neue Position:");
Serial.println(String(potPos).c_str());
client.publish(Topic, String(potiPos).c_str(), true);
}
}
}

Nur Grundgerüst, 
gültiges Programm

siehe Beilage
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Resultat auf Node-Red sichtbar machen

Unter…….“IP-Adresse“:1880

Ich habe dazu das Program „Node-Red“ verwendet. Dies läuft auf 
PC/MAC/Ubuntu/Raspberry Pi etc.

Empfangene Daten auf 
UI anzeigen

Nur zum Testen
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Anzeige auf Mobil Telefon 

Unter…….“IP-Adresse“:1880/ui
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Anwendungen im Amateurfunk

• Für was ist der Arduino weniger geeignet?

• Wenn grosse Datenmengen verarbeitet 
werden müssen.

• Ansteuern von Graphikdisplays

• FT8-Signale dekodieren
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Welche Anwendungen kennen wir?
• AD9850 ansteuern (VFO etc.)

• Programmierbarer Oszi Si570  0.5….160Mhz von Axe Schultze, DK4AQ

• ARDUINO©- Mikrocontroller im Amateurfunk von Mathias Dahlke, DJ9MD

• ADF4351-Baustein von SV1AFN http://www.kh-gps.de/adf4351.htm

• Stationsuhr von Ingo, DL6IS https://p34.meindarc.de/?p=1182

• Morsekeyer von Ingo, DL6IS https://p34.meindarc.de/?p=1198

• SWR Analyser von Daniel, DL2AB https://wiki.funkfreun.de/projekte/swr-analyser

• CAT- Interface http://www.kh-gps.de/Arduino_8f.pd

• Rotor- Interface, K3NG https://blog.radioartisan.com/yaesu-rotator-computer-serial-interface

• μBitX Transceiver mit Nextion© 

• APRS-Terminal von Jürgen, DL8MA  http://www.dl8ma.de/Arduino/APRS-Terminal/

• Remote Power/SWR Meter  von Michael Clemens, DK1MI.radio --: HB9MFM

• …..zig viele Beispiele im Internet

http://www.kh-gps.de/adf4351.htm
https://p34.meindarc.de/?p=1182
https://p34.meindarc.de/?p=1198
https://wiki.funkfreun.de/projekte/swr-analyser
http://www.kh-gps.de/Arduino_8f.pd
https://blog.radioartisan.com/yaesu-rotator-computer-serial-interface
http://www.dl8ma.de/Arduino/APRS-Terminal/
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